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About This Manual

The LabVIEW Data Acquisition Basics Manual includes the information
you need to get started with data acquisition and LabVIEW. You should
have a basic knowledge of LabVIEW before you try to read this manual. If
you have never worked with LabVIEW, please read through the LabVIEW
QuickStart Guide or the LabVIEW Online Tutorial before you begin. This
manual shows you how to configure your software, teaches you basic
concepts needed to accomplish your task, and refers you to common
example VIs in LabVIEW. If you have used LabVIEW for data acquisition
before, you can use this book as a troubleshooting guide.

This manual supplements the LabVIEW User Manual, and assumes that
you are familiar with that material. You also should be familiar with the
operation of LabVIEW, your computer, your computer's operating system,
and your data acquisition (DAQ) device.

Conventions Used in This Manual

<>

»

5
@

italic

The following conventions are used in this manual:

Angle brackets that contain numbers separated by an ellipsis represent a
range of values associated with a bit or signal name—for example,
DBIO<3..0>.

Square brackets enclose optional items—for example, [response].

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.
This icon denotes a tip, which alerts you to advisory information.

Bold text denotes items that you must select or click on in the software,
such as menu items and dialog box options. Bold text also denotes
parameter names.

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.
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About This Manual

monospace

monospace bold

monospace italic

NI-DAQ 4.8.x

NI-DAQ 5.x

NI-DAQ 6.0

Platform

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

Bold text in this font denotes the messages and responses that the computer
automatically prints to the screen. This font also emphasizes lines of code
that are different from the other examples.

Ttalic text in this font denotes text that is a placeholder for a word or value
that you must supply.

NI-DAQ 4.8.x refers to functions supported only on the Macintosh for
NuBus DAQ products.

NI-DAQ 5.x refers to functions supported only on Windows DAQ products.

NI-DAQ 6.0 refers to functions supported only on Windows and PCI-based
Macintosh DAQ products.

Text in this font denotes a specific platform and indicates that the text
following it applies only to that platform.
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About This Manual

LabVIEW Data Types

Each VI description gives a data type picture for each input and output
parameter, as illustrated in the following table:

Control Indicator Data Type

Signed 8-bit integer

Signed 16-bit integer

Signed 32-bit integer

Unsigned 8-bit integer

Unsigned 16-bit integer

Unsigned 32-bit integer

Single-precision floating-point number

Double-precision floating-point number

Extended-precision floating-point
number

String

T TF Boolean

bl

132 Array of signed 32-bit integers

2D Array of signed 32-bit integers

Cluster

HBEEEE EEEEEEBEE
o8 & EE R E

File Refnum
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About This Manual

Related Documentation

The following documents contain information you might find helpful as
you read this manual:

LabVIEW QuickStart Guide

LabVIEW User Manual

G Programming Reference Manual
LabVIEW Function and VI Reference Manual

LabVIEW Online Reference, available online by selecting
Help»Online Reference

LabVIEW Online Tutorial, which you launch from the LabVIEW
dialog box (Windows)

Application Note 025, Field Wiring and Noise Considerations for
Analog Signals

Application Note 046, Measuring Temperature with RTDs—A Tutorial

The user manuals for the data acquisition boards you use
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Part |

Before You Get Started

This section contains all the information you should know before you
start learning about data acquisition with LabVIEW.

Part I, Before You Get Started, contains the following chapters:

e Chapter 1, How To Use This Book, explains how this manual is
organized.

e Chapter 2, Installing and Configuring Your Data Acquisition
Hardware, explains how to set up your system to use data acquisition
with LabVIEW and your data acquisition hardware.

e Chapter 3, Basic LabVIEW Data Acquisition Concepts, explains key
concepts in understanding how data acquisition works with LabVIEW.

*  Chapter 4, Where You Should Go Next, directs you to the chapter or
chapters in the manual best suited to answer questions about your data
acquisition application.
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How To Use This Book

This chapter explains how this manual is organized. The following outline
shows you what information you can find in this manual.
PartI Before You Get Started
How to Use This Book
Installing and Configuring Your Data Acquisition Hardware
Basic LabVIEW Data Acquisition Concepts
Where You Should Go Next

Part I Catching the Wave with Analog Input
Things You Should Know about Analog Input
One-Stop Single-Point Acquisition
Buffering Your Way through Waveform Acquisition
Controlling Your Acquisition with Triggers

Letting an Outside Source Control Your Acquisition Rate

Part III Making Waves with Analog Output
Things You Should Know about Analog Output
One-Stop Single-Point Generation
Buffering Your Way through Waveform Generation
Letting an Outside Source Control Your Update Rate

Simultaneous Buffered Waveform Acquisition and Generation

Part IV Getting Square with Digital I/O
Things You Should Know about Digital I/O
When You Need It Now—Immediate Digital I/O
Shaking Hands with a Digital Partner
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Chapter 1 How To Use This Book

Part V. SCXI—Getting Your Signals in Great Condition
Things You Should Know about SCXI
Hardware and Software Setup for Your SCXI System
Special Programming Considerations for SCXI
Common SCXT Applications

SCXI Calibration—Increasing Signal Measurement Precision

Part VI Counting Your Way to High-Precision Timing
Things You Should Know about Counters
Generating a Square Pulse or Pulse Trains
Measuring Pulse Width
Measuring Frequency and Period
Counting Signal Highs and Lows

Dividing Frequencies

Part VII Debugging Your Data Acquisition Application
Debugging Techniques
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Chapter 1 How To Use This Book

If you already have started a LabVIEW DAQ application, please refer to
Chapter 2, Installing and Configuring Your Data Acquisition Hardware,
to check your configuration. Refer to Part VII, Debugging Your Data
Acquisition Application, for information on common errors. The following
flowchart shows the steps to follow before running your application.

( Install and Configure Your Hardware )

( Learn Basic Data Acquisition Concepts

'

C Go to Your Specific Application Section

)

)
:

)

)

C Review LabVIEW Example Applications

'

C Learn How to Debug Your Application

© National Instruments Corporation

Install and Configure Your Hardware—When you install
LabVIEW, the program prompts you to have the data acquisition
(DAQ) drivers installed. This manual guides you through setting up
NI-DAQ software with your DAQ device and SCXI hardware. You
should read any unique installation instructions for your platform in
Chapter 2, Installing and Configuring Your Data Acquisition
Hardware.

Learn Basic Data Acquisition Concepts—Chapter 3, Basic
LabVIEW Data Acquisition Concepts, shows you the location of
DAQ example VIs; DAQ VI organization; VI parameter conventions;
default and current value conventions; common VI parameter
definitions; error handling; channel, port and counter addressing;
limit settings; and data organization for analog applications.
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How To Use This Book

Go to Your Specific Application Section—Chapter 4, Where You
Should Go Next, shows you where to find information in this manual
for your application.

Review LabVIEW Example Applications—The remaining chapters
teach you basic concepts in analog input and output, digital I/O,
counters, and SCXI. Each application section first lists example Vs,
then describes the basic concepts needed to understand these example
VIs. Whenever possible, you should have the VI open as you refer to
these examples.

Learn How to Debug Your Application—Chapter 29, Debugging
Techniques, describes the different ways you can debug your
application. This chapter helps you troubleshoot for common
programming errors.
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Installing and Configuring Your
Data Acquisition Hardware

This chapter explains how to set up your system to use data acquisition
with LabVIEW and your data acquisition hardware. The chapter contains
hardware installation and configuration and software configuration
instructions and some general information and techniques.

@ Note The LabVIEW installer prompts you to have the NI-DAQ driver software installed.
All National Instruments data acquisition (DAQ) devices are packaged with NI-DAQ driver
software. The version of NI-DAQ packaged with your DAQ device might be newer than
the version installed by LabVIEW. You can determine the NI-DAQ version in LabVIEW

inFo] by running the Get DAQ Device Information VI, located in Functions»Data
Acquisition»Calibration and Configuration.

After installing LabVIEW and the NI-DAQ driver, follow the steps
in Figure 2-1 to install your hardware and complete the software
configuration. LabVIEW uses the software configuration information
to recognize your hardware and to set default DAQ parameters.
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Chapter 2

Installing and Configuring Your Data Acquisition Hardware

Install Plug-in Devices )

\ 4

[Use Measurement & Automation Explorej

or Your Configuration Utility
to Configure Devices

:

\ 4

[ Install and Configure SCXI )

\4

Use the Measurement & Automation Explorer
(NI-DAQ 6.5 or higher for Windows 9x/NT)
to configure Al, AO, or DIO channels.
or
Use the DAQ Channel Wizard
(NI-DAQ 6.1 or lower, Windows 9x/NT or Macintosh)
to configure Al, AO, or DIO channels.

\ 4

Read Chapter 3, Basic Data Acquisition Concepts,
and Chapter 4, Where You Should Go Now

Figure 2-1. Installing and Configuring DAQ Devices

NI-DAQ driver software provides LabVIEW with a high-level interface to
DAQ devices and signal conditioning hardware.
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Chapter 2 Installing and Configuring Your Data Acquisition Hardware

Figure 2-2 shows the relationship between LabVIEW, NI-DAQ, and
DAQ hardware.

LabVIEW Vls

NI-DAQ Drivers

Data Acquisition Devices

Figure 2-2. How NI-DAQ Relates to Your System and DAQ Devices

(NI-DAQ 4.8.x for Macintosh) NI-DAQ 4.8.x for the Macintosh device drivers
are bundled in a single file that determines which drivers to load. When you
restart your computer, this control panel driver, called NI-DAQ, determines
which devices are installed in the system and loads their corresponding
drivers. NI-DAQ uses its control panel settings to determine what Signal
Conditioning eXtensions for Instrumentation (SCXI) hardware is
configured and what the default device settings are for devices in the
computer. If you use DMA, NI-DAQ also communicates with the
NI-DMA/DSP for DMA services. When you install LabVIEW, the installer
places both of these files on your hard drive.

(NI-DAQ 6. x for Macintosh) The NI-DAQ driver, called NI-DAQ is installed
in the National Instruments folder in your Macintosh Extensions folder.

(NI-DAQ 5.x, 6.x for Windows) The NI-DAQ driver, NIDAQ32 .DLL, i$
installed in your Windows SYSTEM or SYSTEM32 directory.
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Chapter 2

Installing and Configuring Your Data Acquisition Hardware

LabVIEW Data Acquisition Hardware Support

National Instruments periodically upgrades LabVIEW to add support for
new DAQ hardware. To make sure this version of LabVIEW supports the
hardware you use, refer to the following table.

Table 2-1. LabVIEW DAQ Hardware Support with NI-DAQ

NI-DAQ Version Support

Device Type Device Windows 9x Windows NT 4.0 | Windows 2000 Macintosh
PCI Bus NI 4060 for PCI 6.1 and higher 6.1 and higher 6.6 and higher N/A
Devices
NI 4351 for PCI 6.5 and higher 6.5 and higher 6.6 and higher N/A
NI 4551 for PCI 6.1 and higher 6.1 and higher 6.6 and higher N/A
NI 4552 for PCI 6.1 and higher 6.1 and higher 6.6 and higher N/A
NI 5102 for PCI 5.0 and higher 5.0 and higher 6.6 and higher N/A
NI 5401 for PCI 6.5.2 and higher 6.5.2 and higher 6.6 and higher N/A
NI 5411 for PCI 5.0 and higher 5.0 and higher 6.6 and higher N/A
NI 5431 for PCI 6.5 and higher 6.5 and higher 6.6 and higher N/A
PCI-1200 4.9 and higher 5.0 and higher 6.6 and higher 4.9 and higher
PCI-4451 6.1 and higher 6.1 and higher 6.6 and higher N/A
PCI-4452 6.1 and higher 6.1 and higher 6.6 and higher N/A
PCI-4453 6.6 and higher 6.6 and higher 6.6 and higher N/A
PCI-4454 6.6 and higher 6.6 and higher 6.6 and higher N/A
PCI-6023E 6.5 and higher 6.5 and higher 6.6 and higher N/A
PCI-6024E 6.5 and higher 6.5 and higher 6.6 and higher N/A
PCI-6025E 6.5 and higher 6.5 and higher 6.6 and higher N/A
PCI-6031E 5.1 and higher 5.1 and higher 6.6 and higher 6.0 and higher
PCI-6032E 5.1 and higher 5.1 and higher 6.6 and higher 6.0 and higher
PCI-6033E 5.1 and higher 5.1 and higher 6.6 and higher 6.0 and higher
PCI-6034E 6.6 and higher 6.6 and higher 6.6 and higher N/A
PCI-6035E 6.6 and higher 6.6 and higher 6.6 and higher N/A
PCI-6052E 6.5 and higher 6.5 and higher 6.6 and higher N/A
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Installing and Configuring Your Data Acquisition Hardware

Table 2-1. LabVIEW DAQ Hardware Support with NI-DAQ (Continued)

NI-DAQ Version Support

Device Type Device Windows 9x Windows NT 4.0 | Windows 2000 Macintosh

PCI Bus PCI-6071E 5.1 and higher 5.1 and higher 6.6 and higher 6.0 and higher

?Ce(\)/rll(t:iensued) PCI-6110E 6.1 and higher 6.1 and higher 6.6 and higher 6.1 and higher
PCI-6111E 6.1 and higher 6.1 and higher 6.6 and higher 6.1 and higher
PCI-6503 6.1 and higher 6.1 and higher 6.6 and higher N/A
PCI-6527 6.6 and higher 6.6 and higher 6.6 and higher N/A
PCI-6601 6.6 and higher 6.6 and higher 6.6 and higher N/A
PCI-6602 6.5 and higher 6.5 and higher 6.6 and higher N/A
PCI-6608 6.6 and higher 6.6 and higher 6.6 and higher N/A
PCI-6703 6.6 and higher 6.6 and higher 6.6 and higher N/A
PCI-6704 6.5 and higher 6.5 and higher 6.6 and higher N/A
PCI-6711 6.5 and higher 6.5 and higher 6.6 and higher N/A
PCI-6713 6.5 and higher 6.5 and higher 6.6 and higher N/A
PCI-7030?2 6.5 and higher 6.5 and higher 6.6 and higher N/A
PCI-70402 6.5 and higher 6.5 and higher 6.6 and higher N/A
PCI-DIO-32HS 5.0 and higher 5.0 and higher 6.6 and higher 6.0 and higher
PCI-DIO-96 4.9 and higher 5.0 and higher 6.6 and higher 4.9 and higher
PCI-MIO-16E-1 5.0 and higher 5.0 and higher 6.6 and higher 6.0 and higher
PCI-MIO-16E-4 5.0 and higher 5.0 and higher 6.6 and higher 6.0 and higher
PCI-MIO-16XE-10 5.0 and higher 5.0 and higher 6.6 and higher 6.0 and higher
PCI-MIO-16XE-50 4.9 and higher 5.0 and higher 6.6 and higher 4.9 and higher

PXI Combo PXI-1010 6.0 and higher 6.0 and higher 6.6 and higher N/A

Chassis PXI-1011 6.6 and higher 6.6 and higher 6.6 and higher N/A
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Installing and Configuring Your Data Acquisition Hardware

Table 2-1. LabVIEW DAQ Hardware Support with NI-DAQ (Continued)

NI-DAQ Version Support

Device Type Device Windows 9x Windows NT 4.0 | Windows 2000 Macintosh

PXI Bus NI 4060 for PXI 6.1 and higher 6.1 and higher 6.6 and higher N/A

Devices NI 4351 for PXI 6.5 and higher 6.5 and higher 6.6 and higher N/A
NI 5102 for PXI 6.0 and higher 6.0 and higher 6.6 and higher N/A
NI 5401 for PXI 6.5.2 and higher 6.5.2 and higher 6.6 and higher N/A
NI 5411 for PXI 6.5 and higher 6.5 and higher 6.6 and higher N/A
NI 5431 for PXI 6.5 and higher 6.5 and higher 6.6 and higher N/A
PXI-6011E 5.1 and higher 5.1 and higher 6.6 and higher N/A
PXI-6025E 6.5 and higher 6.5 and higher 6.6 and higher N/A
PXI-6030E 5.1 and higher 5.1 and higher 6.6 and higher N/A
PXI-6031E 6.1 and higher 6.1 and higher 6.6 and higher N/A
PXI-6035E 6.6 and higher 6.6 and higher 6.6 and higher N/A
PXI-6040E 5.1 and higher 5.1 and higher 6.6 and higher N/A
PXI-6052E 6.6 and higher 6.6 and higher 6.6 and higher N/A
PXI-6070E 5.1 and higher 5.1 and higher 6.6 and higher N/A
PXI-6071E 6.1 and higher 6.1 and higher 6.1 and higher N/A
PXI-6508 6.0 and higher 6.0 and higher 6.6 and higher N/A
PX1-6527 6.6 and higher 6.6 and higher 6.6 and higher N/A
PXI-6533 5.1 and higher 5.1 and higher 6.6 and higher N/A
PXI-6602 6.5 and higher 6.5 and higher 6.6 and higher N/A
PXI-6608 6.6 and higher 6.6 and higher 6.6 and higher N/A
PXI-6703 6.6 and higher 6.6 and higher 6.6 and higher N/A
PXI-6704 6.5 and higher 6.5 and higher 6.6 and higher N/A
PXI-6711 6.5 and higher 6.5 and higher 6.6 and higher N/A
PX1-6713 6.5 and higher 6.5 and higher 6.6 and higher N/A
PXI-7030? 6.5 and higher 6.5 and higher 6.6 and higher N/A
PXI-7040? 6.5 and higher 6.5 and higher 6.6 and higher N/A
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Table 2-1. LabVIEW DAQ Hardware Support with NI-DAQ (Continued)

NI-DAQ Version Support

Device Type Device Windows 9x Windows NT 4.0 | Windows 2000 Macintosh
PC Card DAQCard-500 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
Devices DAQCard-700 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
DAQCard-1200 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
DAQCard-516 4.9 and higher 5.0 and higher 6.6 and higher 6.0 and higher
DAQCard-6023E 6.6 and higher 6.6 and higher 6.6 and higher N/A
DAQCard-6024E 6.6 and higher 6.6 and higher 6.6 and higher N/A
DAQCard-6062E 6.6 and higher 6.6 and higher 6.6 and higher N/A
DAQCard-6533 5.1 and higher 5.1 and higher 6.6 and higher 6.0 and higher
DAQCard-6723 6.6 and higher 6.6 and higher 6.6 and higher N/A
DAQCard-AI-16E-4 4.9 and higher 5.0 and higher 6.6 and higher 6.0 and higher
DAQCard-AI-16XE-50 4.9 and higher 5.0 and higher 6.6 and higher 6.0 and higher
DAQCard-AO-2DC 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
DAQCard-DIO-24 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
NI 4050 for PCMCIA 5.0 and higher 5.0 and higher 6.6 and higher N/A
NI 4350 for PCMCIA 5.1 and higher 5.1 and higher 6.6 and higher N/A
NI 5102 for PCMCIA 5.0 and higher 5.0 and higher 6.6 and higher N/A
External DAQPad-1200' 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
Devices DAQPad-6020E (USB) 6.5 and higher? N/A 6.6 and higher N/A
DAQPad-6052E (1394) 6.6 and higher? N/A 6.6 and higher N/A
DAQPad-6070E (1394) 6.5 and higher? N/A 6.6 and higher N/A
DAQPad-6507/6508 6.0 and higher? N/A 6.6 and higher N/A
(USB)
DAQPad-6533 (1394) 6.5 and higher? N/A 6.6 and higher N/A
DAQPad-6713 (1394) 6.5 and higher? N/A 6.6 and higher N/A
DAQPad-MIO-16XE-50! | 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
NI 4350 for USB 6.0 and higher? N/A 6.6 and higher N/A
NI 5102 for USB 6.0 and higher? N/A 6.6 and higher N/A
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Table 2-1. LabVIEW DAQ Hardware Support with NI-DAQ (Continued)

NI-DAQ Version Support

Device Type Device Windows 9x Windows NT 4.0 | Windows 2000 Macintosh

AT Bus AT-A2150 4851049 Contact NI N/A N/A

Devices
AT-AI-16XE-10 4.9 and higher 5.0 and higher 6.6 and higher N/A
AT-AO-6/10 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
AT-DIO-32F 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
AT-DIO-32HS 5.0 and higher 5.0 and higher 6.6 and higher N/A
AT-DSP2200 4851049 Contact NI N/A N/A
AT-MIO-16/16D 4.8.51t06.1 5.0t06.1 N/A N/A
AT-MIO-16DE-10 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
AT-MIO-16E-1 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
AT-MIO-16E-2 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
AT-MIO-16E-10 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
AT-MIO-16F-5 4.851t06.1 5.0t06.1 N/A N/A
AT-MIO-16X 4.8.5t06.1 5.0t06.1 N/A N/A
AT-MIO-16XE-10 4.9 and higher 5.0 and higher 6.6 and higher N/A
AT-MIO-16XE-50 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
AT-MIO-64E-3 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
AT-MIO-64F-5 4.851t06.1 5.0t06.1 N/A N/A
NI 5102 for ISA 5.0 and higher 5.0 and higher 6.6 and higher N/A
NI 5411 for ISA 5.0 and higher 5.0 and higher 6.6 and higher N/A
NI 5431 for ISA 6.5 and higher 6.5 and higher 6.6 and higher N/A
EISA-A2000 485t04.9 Contact NI N/A N/A
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Table 2-1. LabVIEW DAQ Hardware Support with NI-DAQ (Continued)

NI-DAQ Version Support

Device Type Device Windows 9x Windows NT 4.0 | Windows 2000 Macintosh
PC/XT Bus NI 4350 for ISA 5.1 and higher 5.1 and higher 6.6 and higher N/A
Devices
PC-516 4.9 and higher 5.0 and higher 6.6 and higher N/A
PC-AO-2DC 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
PC-DIO-24 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
PC-DIO-24PnP 6.0 and higher 5.0 and higher 6.6 and higher N/A
PC-DIO-96 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
PC-DIO-96PnP 6.0 and higher 5.0 and higher 6.6 and higher N/A
PC-LPM-16 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
PC-LPM-16PnP 4.9 and higher 5.0 and higher 6.6 and higher N/A
PC-OPDIO-16 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
PC-TIO-10 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
Lab Series Lab-PC+ 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
Devices Lab-PC-1200 4.9 and higher 5.0 and higher 6.6 and higher N/A
Lab-PC-1200AI 4.9 and higher 5.0 and higher 6.6 and higher N/A
Lab-LC N/A N/A N/A 48t04.9
Lab-NB N/A N/A N/A 4.8t04.9
NEC Devices | NEC-AI-16E-4 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
NEC-AI-16XE-50 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
NEC-MIO-16E-4 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
NEC-MIO-16XE-50 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
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Table 2-1. LabVIEW DAQ Hardware Support with NI-DAQ (Continued)

NI-DAQ Version Support

Device Type Device Windows 9x Windows NT 4.0 | Windows 2000 Macintosh
NuBus NB-A2000 N/A N/A N/A 48t04.9
Devices
NB-A2150 N/A N/A N/A 4.8t04.9
NB-A2100 N/A N/A N/A 4.8t04.9
NB-AO-6 N/A N/A N/A 4.8t04.9
NB-DIO-24 N/A N/A N/A 4.8t04.9
NB-DIO-32F N/A N/A N/A 4.8t04.9
NB-DIO-96 N/A N/A N/A 4.8t04.9
NB-DMA-8-G N/A N/A N/A 4.8t04.9
NB-DMA2800 N/A N/A N/A 4.8t04.9
NB-MIO-16 N/A N/A N/A 4.8t04.9
NB-MIO-16X N/A N/A N/A 4.8t04.9
NB-TIO-10 N/A N/A N/A 4.8t04.9
VXI Carriers | VXI-AO-48XDC 4.9 and higher 5.0 and higher 6.6 and higher N/A
and Modules
VXI-DIO-128 4.9 and higher 5.0 and higher 6.6 and higher N/A
VXI-MIO-64E-1 4.9 and higher 5.0 and higher 6.6 and higher N/A
VXI-MIO-64XE-10 4.9 and higher 5.0 and higher 6.6 and higher N/A
VXI-SC-1000 5.0 and higher 5.0 and higher 6.6 and higher N/A
VXI-SC-1102 5.0 and higher 5.0 and higher 6.6 and higher N/A
VXI-SC-1102B 5.1 and higher 5.1 and higher 6.6 and higher N/A
VXI-SC-1102C 5.1 and higher 5.1 and higher 6.6 and higher N/A
VXI-SC-1104 6.5 and higher 6.5 and higher 6.6 and higher N/A
VXI-SC-1150 5.0 and higher 5.0 and higher 6.6 and higher N/A
SCXI SCXI-1000 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
Chassis SCXI-1000DC 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1001 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-2000 4.9 and higher 5.0 and higher 6.6 and higher N/A
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Table 2-1. LabVIEW DAQ Hardware Support with NI-DAQ (Continued)

NI-DAQ Version Support

Device Type Device Windows 9x Windows NT 4.0 | Windows 2000 Macintosh

SCXI SCXI-1100 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher

Modules
SCXI-1101 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCXI-1102 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1102B 5.1 and higher 5.1 and higher 6.6 and higher 6.0 and higher
SCXI-1102C 5.1 and higher 5.1 and higher 6.6 and higher 6.0 and higher
SCXI-1104 6.5 and higher 6.5 and higher 6.6 and higher N/A
SCXI-1112 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCXI-1120 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1120D 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1121 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1122 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1124 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1125 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCXI-1126 6.0 and higher 6.0 and higher 6.6 and higher 6.0 and higher
SCXI-1127 6.5.2 and higher 6.5.2 and higher 6.6 and higher N/A
SCXI-1140 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1141 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1142 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCXI-1143 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCXI-1160 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1161 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1162 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1162HV 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1163 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1163R 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SCXI-1200! 4.8.5 and higher 5.0 and higher 6.6 and higher N/A
SCXI-2400 4.9 and higher 5.0 and higher 6.6 and higher N/A
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Table 2-1. LabVIEW DAQ Hardware Support with NI-DAQ (Continued)

NI-DAQ Version Support

Device Type Device Windows 9x Windows NT 4.0 | Windows 2000 Macintosh

Accessories AMUX-64T 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SC-2040 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SC-2042-RTD 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher
SC-2043-SG 4.8.5 and higher 5.0 and higher 6.6 and higher 4.8 and higher

Signal SC-2345 6.0 and higher 6.0 and higher 6.6 and higher 6.0 and higher

Conditioning

Components SCC-A10 6.0 and higher 6.0 and higher 6.6 and higher 6.0 and higher

(Csise)r:“d SCC-AIOI 6.6and higher | 6.6 and higher | 6.6and higher N/A
SCC-AI02 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCC-AIO3 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCC-AIO4 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCC-AIO5 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCC-AI06 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCC-AI07 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCC-AI13 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCC-All14 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCC-CI20 6.0 and higher 6.0 and higher 6.6 and higher 6.0 and higher
SCC-DI01 6.5 and higher 6.5 and higher 6.6 and higher N/A
SCC-DOO01 6.5 and higher 6.5 and higher 6.6 and higher N/A
SCC-FTO01 6.0 and higher 6.0 and higher 6.6 and higher 6.0 and higher
SCC-LPO1 6.1 and higher 6.1 and higher 6.6 and higher 6.1 and higher
SCC-LP02 6.1 and higher 6.1 and higher 6.6 and higher 6.1 and higher
SCC-LPO3 6.1 and higher 6.1 and higher 6.6 and higher 6.1 and higher
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Table 2-1. LabVIEW DAQ Hardware Support with NI-DAQ (Continued)

NI-DAQ Version Support

Device Type Device Windows 9x Windows NT 4.0 | Windows 2000 Macintosh

Signal SCC-PWRO1 6.0 and higher 6.0 and higher 6.6 and higher 6.0 and higher

Conditioning

Components SCC-PWRO02 6.0 and higher 6.0 and higher 6.6 and higher 6.0 and higher

gfggr:“d SCC-PWR03 6.0 and higher | 6.0 and higher | 6.6and higher | 6.0 and higher

(Continued) SCC-SGO1 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCC-SG02 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCC-SG03 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCC-SG04 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCC-SG11 6.6 and higher 6.6 and higher 6.6 and higher N/A
SCC-TCO1 6.0 and higher 6.0 and higher 6.6 and higher 6.0 and higher
SCC-TC02 6.0 and higher 6.0 and higher 6.6 and higher 6.0 and higher

' The DAQPad-MIO-16XE-50 and DAQPad-1200 do not work with NEC PC-9800 Series computers. The SCXI-1200

works with NEC PC-9800 Series computers ONLY when used with Remote SCXI.

2 Requires LabVIEW/RT.

3 USB and IEEE-1394 devices are supported only on Windows 98 and Windows 2000. There is no support under

Windows 95 and Windows NT 4.0.

© National Instruments Corporation

For more information regarding hardware support for LabVIEW, refer to
Appendix B, Hardware Capabilities, in the LabVIEW Function and VI
Reference Manual, or the LabVIEW Online Reference, by selecting
Help»Online Reference.
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Chapter 2 Installing and Configuring Your Data Acquisition Hardware

Installing and Configuring Your
National Instruments Device

Some DAQ devices have jumpers to set analog input polarity, input mode,
analog output reference, and so on. Before you install your device, check
your hardware user manuals to see if your device has jumpers and how to
change its settings. You then can determine whether you need to change
any jumper settings. Record any jumper settings that you change so that
you can enter the information correctly in the configuration utility.

The next step depends on what version of NI-DAQ you have. Go to the
appropriate section below to continue the configuration of your devices.

Installing and Configuring Your DAQ Device Using NI-DAQ 5.x, 6.x

You can refer to the online help for specific instructions on how to install
and configure your DAQ device. If you are using Windows 9x/NT with
NI-DAQ 6.5 or higher, refer to the help file for Measurement &
Automation Explorer by selecting Help»Help Topics»DAQ Help. If you
are using an earlier version of NI-DAQ for Windows, you can find the help
file in Start»>Programs»LabVIEW»NI-DAQ Configuration Utility
Help. If you are using a Macintosh, you can find the help file in the Help
menu of the NI-DAQ Configuration Utility.

Configuring Your DAQ Device Using NI-DAQ 4.8.x on the Macintosh

ke

NI-DAQ

After you check and record your jumper settings, turn off your computer
and insert your National Instruments devices.

Turn your computer back on. You can find NI-DAQ in your control
panels folder. The NI-DAQ icon looks like the one shown to the left.
Double-click on this icon to launch NI-DAQ.

When you launch the program, NI-DAQ displays a list of all of the devices
in your computer. Each device has a list of attributes, as shown in

Figure 2-3. The number specified in the device line is the logical device
number that NI-DAQ assigned to the device. You use this number in
LabVIEW as the device number to select that device for any operation.
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Fi=——— NI-DAl ——
1‘.;?’ 4.8.5
#° [Help] [Devices |
Active Devices - i
device: z
niame : PCI-1200
type: 353
bus: FCl
socket:
address: C:20204000
device: 3
niame : PCI-010-96
type: 352
bus: FCl
socket: [
address: Oxc20201000
[

Figure 2-3. NI-DAQ Device Window Listing

Now show the Device Configuration window by selecting the
Device Configuration option from the menu as shown in Figure 2-4.

E=—— NI-Dil =——

- 4.8.5 |
»

 Devices
Device Configuration

Help

Active DeVITery | Configuration &
device: Errors |
name: FLT=T.200
type: 353
bus: FCI
socket:
address: O:20204000
device: 2
name : FCI-D10-25
type: 352
bus: FCI
socket: ci
address: C:20201000
i

Figure 2-4. Accessing the Device Configuration Window in NI-DAQ

Figure 2-5 shows the NI-DAQ Device Configuration window. When you
are in the Device Configuration window of the utility, you can edit the
default settings for parameters, such as analog input polarity and range
on a per-device basis. If you are using AMUX-64T or signal conditioning
devices with your DAQ device, select the appropriate device using the
Accessories menu. LabVIEW uses these settings when initializing the
device instead of the default settings listed in the descriptions of the
hardware configuration VIs. (You can use these VIs to change any

setting recorded by NI-DAQ.) When you click on the name of the device,
NI-DAQ displays the I/O connector for the device, as shown in Figure 2-5.
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Installing and Configuring Your Data Acquisition Hardware

EO=—— NI-Dil =——

1!‘?[ 4.8.5

Help ] [Device Configuration |

] 2 Te]rc 1 200

1/0 Subsystem|ADC 0 |
Polarity[Bipolar | Mode[Refer... |
Range[101  |speed

Accessories[None |

channelf<] 0 [z]
Coupling[DC | Gain[1 |
LE - 2E4E Gab

ACHO
ACHZ
ACH4
ACHE
AIGHD
ACGHD
OGHO
FA1
FAZ
FAS
FA7
FE1
FEZ
FES
FE?
FC1
PC3
PCS
PC?
EXTUFDOATE*
auTED
OuTE 1
CLEET
GATEEZ
+5 U

2 [ACH1

4 |ACHZ2

6 [ACHS

2  [ACH?

9 [ 10 [DRCO OUT
11] 12 |DACT OUT
12 | 14 |PRO

15 | 16 |PRZ

17 | 12 |PR4

19 | 20 |PRG
21|22 |PEO

23 | 24 |FBZ2

25 | 26 |FB4

27 | 28 |PBE

29 | 20 |PCO

21| 22 |PC2

22 134 |PC4

25 | 26 |PCE

27 |28 EXTTRIG
29 | 40 |EXTCOHU*
41 | 42 |GATEED
43 | 44 |GARTEE1
45 | 46 |0UTEZ

47 | 48 |CLKEZ

49 | 50 |DGHD

PC1-1200

Figure 2-5. Device Configuration and I/0 Connector Windows in NI-DAQ

You also can find additional information by clicking the Help button. If at
any time during configuration you need to view a list of the LabVIEW DAQ
error codes and their meanings, you can do so by clicking on the NI-DAQ
menu bar, located to the right of the Help button, and choosing Errors.

Note Some DAQ devices, such as the Lab-NB and NB-MIO-16 devices, require hardware
jumper changes in addition to software configuration. Consult your DAQ device hardware
reference manual for more information.

The following section describes the procedures for installing and

configuring your SCXI chassis.

Hardware Configuration

Your SCXI hardware kit includes the Getting Started with SCXI manual,
which contains detailed instructions for assembling your SCXI system,
module jumper settings, cable assemblies, and terminal blocks.

LabVIEW Data Acquisition Basics Manual 2-16
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The following are the basic steps you must complete to assemble your
SCXI system:

1.

7.

Check the jumpers on your modules. Generally, you will leave the
jumpers in their default positions. However, the Getting Started with
SCXI manual contains a section for each module type that lists cases
where you might want to change the jumper settings.

Turn off the chassis power. Plug in your modules through the front of
the chassis. You can put the modules in any slot. For simplicity, start
with slot 1 on the left side of the chassis and move right with each
additional module. Be sure to tightly screw the modules into the
chassis frame.

If you are using an SCXI-1180 feedthrough panel, you must install the
SCXI-1180 in the slot immediately to the right of the module that you
will cable to the DAQ device. Otherwise, the cable connectors might
not fit together conveniently.

If you have more than one chassis, select a unique jumpered address
for each additional chassis by using the jumpers directly behind the
front panel of the chassis.

Plug the appropriate terminal blocks into the front of each module and
screw them tightly into the chassis frame.

If you are using a DAQ device in your computer to control your
SCXI chassis, connect the mounting bracket of the SCXI-134x
(where x is a number) cable assembly to the back of one of the modules
and screw it into the chassis frame. Connect the other end of the cable
to the DAQ device in your computer. In multiplexed mode, you need
to connect only one module to the DAQ device. In most cases, it does
not matter which module you cable. The following are two special
cases where you must cable a specific module to the device:

a. If you use SCXI-1140 modules with other types of modules, you
need to cable one of the SCXI-1140 modules to the DAQ device.

b. If you use analog input modules and other types of modules, you
need to cable one of the analog input modules to the DAQ device.

Turn on your chassis power.

Refer to the Getting Started with SCXI manual for more information about
related topics, such as multichassis cabling.

© National Instruments Corporation
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NI-DAQ 5.x, 6.x Software Configuration

You can refer to the online help for specific instructions on how to install
and configure your DAQ device. If you are using Windows 9x/NT with
NI-DAQ 6.5 or higher, refer to the help file for Mea